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PREFACE
The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web 
site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on 
your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be 
downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web 
Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on 
the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for 
assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part 
number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology 
Network (OTN) Web site.

Agile Training Aids

Go to the Agile Training Web page for more information on Agile Training offerings.
vii
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CHAPTER 1
Introducing Product Quality

Management
This chapter provides an overview of Agile Product Quality Management (PQM) features and processes. It 
has the following sections:
❑ What Is Agile Product Quality Management?
❑ Product Service Requests (PSRs)
❑ Quality Change Requests (QCRs)
❑ Quality Tracking Roles
❑ Quality Tracking Process
❑ Quality-Related SmartRules
❑ Quality Searches
❑ Quality Reports
❑ Quality Tracking Tabs and Fields for Other Objects
❑ Getting Started with Agile PLM

What Is Agile Product Quality Management?
Agile Product Quality Management (PQM) comprises a comprehensive set of tools that allows corporations to track 
and manage data about product quality across the enterprise. This includes customer complaints, product and 
manufacturing defects, field failures, and enhancement and corrective and preventive actions requests. Agile PQM 
closes the support loop by unifying the company’s customer service, field sales, manufacturing, and engineering 
organizations, and by tightly linking the company to its customers and partners.

As competition increases, customers are demanding quality product on time and at a lower cost while the product 
lifecycles shorten. Here are the benefits that Agile PQM features offer to improve your organization’s operations and 
save time and money:

❑ Integration with external enterprise Customer Relationship Management (CRM) systems — the ability to import 
customer complaints, manufacturing issues, and additional quality-related information from other enterprise 
applications streamlines the quality tracking process and offers a central repository for tracking product quality 
data.

❑ Improved product quality — tracking defects, finding trends, and determining the root causes of defects in a 
timely manner are the keys to effective defect reduction and improved product quality.

❑ Improved customer satisfaction — the ability to track problem reports and customer complaints lets you 
respond to customers and resolve problems quickly.
1-1
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❑ Lower production, repair costs, and warranty costs — tracking and correcting defects can help reduce the scrap, 
cycle time, and costs associated with rework and repair.

❑ New features enable compliance with ISO-9000, FDA, and other regulations.

Note Your organization’s license must include use of the quality tracking features to access the options described 
in this manual.

The Agile PQM solution is divided into product service requests (PSRs) and quality change requests (QCRs). PSRs 
are used to manage problem reports and non-conformance reports. QCRs are used to manage and associate the 
problem reports with audits and corrective and preventive actions (CAPAs). 

Customers and suppliers are also involved in the Agile PQM solution. Both customers and suppliers can submit 
PSRs.

The following figure illustrates how quality data flows from different sources to PSRs and QCRs.

Figure 1-1: PSR and QCR quality data flow

Product Service Requests (PSRs) 
You can use a product service request (PSR) to report quality incidents or to aggregate a number of other PSRs. The 
Product Service Request class includes problem reports (PRs) and non-conformance reports (NCRs). You use PRs 
to report any generic quality incidents. You use NCRs to report material deviations from the specifications or any 
other specific quality issues.

For more details about PSR objects, see Chapter 2, “Product Service Requests.” 

Problem Reports (PRs)

A problem report contains a basic description of a problem, issue, or incident that occurred, from the customer’s 
perspective. A customer, field service representative, or supplier may submit a problem report, but their view of the 
cause of the problem is not necessarily the actual cause. For example, a problem report might state that the CD drive 
does not stay locked into the computer case, and it might state that the cause of this problem is a malfunctioning 
lock. The actual cause may be something other than the lock, but this won’t be known until your organization 
investigates the problem.

Problem reports can be routed for investigation through a workflow. The investigating team determines the root 
cause of the problem. The user with the Quality Analyst role oversees the processing of problem reports.

You can use Agile Import or the Agile SDK to import problem reports from different CRM systems. 

Non-Conformance Reports (NCRs) 

A customer, field service representative, or supplier may submit a non-conformance report (NCR) to report a basic 
material deviation from specifications or requirements in one or more products. Non-conformance reports can be 
routed for investigation. 

NCRs are typically used in incoming lot inspections or in testing processes, where the Quality Control department 
samples a subset of materials to identify deviations from the specifications. 

Customer complaints

Repair, service data

Manufacturing defect data

Agile PQM

PSR QCR 
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Chapter 1 Introducing Product Quality Management
Quality Change Requests (QCRs) 
The Quality Change Request (QCR) class is used to create and manage audits and corrective and preventive actions 
(CAPAs). An audit is the proactive process of verifying compliance with quality requirements. The CAPA is a formal 
process of addressing any generic quality problems and analyzing the root causes so you can implement corrective 
and preventive actions.

The QCR allows you to aggregate problems into a routable quality record, perform root-cause failure analysis, and 
drive the problems to closure using standard CAPA (corrective and preventive actions) procedures. The CAPA may 
result in changes to a product, process, or supplier.

You can use QCRs to:

❑ Create and manage quality records that aggregate problems related to products, documents, suppliers, and 
customers.

❑ Provide a means for driving quality-related changes by creating changes such as ECOs, MCOs, ECRs, stop ships, 
and deviations.

❑ Route change requests for review and approval, thereby enabling communication and collaboration between the 
originator (Quality Control), root-cause failure analysis (Quality Control and Engineering), resolution 
(Engineering), corrective/preventative action (Quality Management), communication (customers and 
suppliers) and verification (compliance/audit).

❑ Provide an audit trail between problems, corrective and preventive actions, and engineering changes that enables 
internal and external compliance processes.

For example, you receive items from your supplier, and when checking the quality of the items, you identify a 
defective item. To take corrective action, you create a QCR for the defective item and route the QCR for review and 
approval. After the quality change request is approved, you can route the item through the change to make sure that 
the defect is rectified and changed to new revision of the item. 

Audit 

An audit is a proactive process of verifying compliance with quality requirements.

The Default Audits workflow has different statuses from other default workflows. The following diagram shows the 
Default Audits workflow statuses and typical tasks related to audits: 

Figure 1-2: Default Audits workflow and typical tasks

CAPA 

You can use corrective and preventive actions (CAPAs) to address any generic quality problems for one or more 
PSRs. A CAPA could result in the creation of one or more changes that lead to fixing the problems. A CAPA is a 
routable object and is controlled by a workflow.

The Default CAPA workflow has different statuses from other default workflows. The following diagram shows the 
Default CAPA workflow and typical tasks related to audits: 

Prepared Initiated Audited Issued Corrected Validated

Plan audit Schedule
Notify

Conduct 
audit

Write up audit 
results
Issue to affected 
parties

Identify 
corrections
Implement

Verify 
corrections

Workflow

Typical 
tasks

Closed

Close audit
Close PSRs
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Figure 1-3: Default CAPA workflow and typical tasks

Quality Tracking Roles
Product Quality Management provides the following roles:

❑ Quality Analyst — Allows users to submit Product Service Requests and manage their resolution.

❑ Quality Administrator — Allows users to manage Quality Change Requests.

Your Agile PLM administrator may have set up the roles differently on your system. For details about Agile PLM 
roles, see the Agile PLM Administrator Guide.

Quality Tracking Process
The Product Quality Management solution is flexible. You can adapt it to fit your business processes. The following 
diagram illustrates one example of a quality incident process. Following the diagram is a description of each 
numbered step.

Figure 1-4: Basic example of a corrective action process 

The steps outlined in the preceding figure are explained below:

1 Two customers—CUST1 and CUST2—report quality incidents.

2 The support representative creates problem service requests (PSRs) for the reported incidents: PSR-1, PSR-2, 
PSR-3 for CUST1 and PSR-1, PSR-2, PSR-3 for CUST2. These problem reports are submitted to the quality 
analyst.
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3 The quality analyst reviews all the PSRs from different customers. All the PSR incidents from different customers 
appear to be related, so the quality analyst aggregates all these related PSRs into one PSR and creates PSR-4. Then 
the quality analyst routes PSR-4 through the workflow for further processing.

4 The quality administrator creates a quality change request, QCR-1. The QCR includes a list of the items that it 
affects. The QCR is routed, and engineering team determines that the request is valid and merits a change, either 
an ECO, MCO, ECR, stop ship or deviation depending on the problem.

5 A change is created to address the problem. The change analyst routes the change through the workflow.

6 The change is eventually implemented, fixing the original problem. The change analyst sends a notification to 
the quality administrator, who then decides whether the change did indeed address the problem documented in 
the QCR.

7 The quality administrator takes action to close the QCR.

8 PSR-4 is automatically closed through the relationships specified on the Relationships tab.

9 All the child PSRs aggregated to PSR-4 are automatically closed based on the specified relationships. 

10 The quality analyst sends a notification of the problem resolution to CUST1 and CUST2.

The process outlined above is just an example. The flexibility of Agile PQM also allows routable objects to be created 
without any associated problem reports, and QCRs to be created without problem reports. Additionally, multiple 
incidents may lead to one QCR, but a single incident can lead to only one QCR. A QCR may lead to multiple changes 
(such as ECOs or SCOs), or multiple QCRs may lead to one change.

Quality-Related SmartRules
SmartRules are systemwide settings that let you choose how to manage specific behaviors in Agile PLM. Your Agile 
PLM administrator can modify these settings. The following SmartRules are related to Product Quality Management 
processes:

❑ Many Items per PSR 

❑ Many QCR per PSR 

❑ PSR Contains Items and Related PSRs 

❑ Release QCR with Unresolved Items 

For a complete description of these and other SmartRules, see the Agile PLM Administrator Guide.

The PSR Contains Items and Related PSRs SmartRule controls the behavior of the Affected Items tab and the Related PSR tab 
of PSRs. If that SmartRule is set to “Allow,” PSRs can have both affected items and related PSRs. Otherwise, the 
Affected Items tab and the Related PSR tab are mutually exclusive. In other words, if the Affected Items tab lists items, 
then the Related PSR tab is unavailable; and if the Related PSR tab lists PSRs, then the Affected Items tab is unavailable. 
This allows you to choose whether to use a PSR as an aggregation of other PSRs or as a problem report against 
assembly items.

Quality Searches
When you want to find specific PSRs and QCRs, you can perform a quick search by selecting the required search 
from Quality Searches folder. For example, if you are a quality administrator and you want to assign all unassigned 
PSRs to quality analysts, you can do a quick search of all unassigned PSRs. Sample quality searches are listed below:

❑ Unassigned PSRs

❑ Open PSRs

❑ PSRs Submitted More Than X Hours Ago

❑ Open QCRs
1-5



Agile PLM 9.2.1
❑ Closed QCRs 

❑ Released QCRs

❑ Unassigned Submitted QCRs

❑ QCRs Submitted More Than X Hours Ago

Note You will see Quality Searches folder only if your Agile PLM administrator has specified the searches in your 
profile.

Quality Reports
Agile PLM provides several standard reports that help you analyze data in Agile Product Quality Management. In 
the navigation pane of Agile Web Client, the Reports and Analytics > Quality Reports folder lists the following reports:

Each of the Quality reports has a Report Wizard. Step through the wizard, and click Finish on the final page to display 
the report.

To run a Quality report: 

1 Select the report in the Quality Reports folder. The report’s page appears.

2 Click the Execute button. The Select Layout and Configuration page appears. Select the layout you want from the 
drop-down list, or use the Layout Manager to create a new layout. Click Next.

3 Except for the Quality Activity report, the Quality reports let you search for Product Service Requests to use in 
the report. Click Saved Search if you want to use a search from the list of available searches. Click Advanced Search 
to create a new query. Or select All Product Service Requests to use all PSRs. Click Next.

4 Specify other settings for the report. Examples of other Quality report settings include:

• The time period covered

• The time units used in the report

• The workflow used in the report

• The way to group data to evaluate trends 

5 Click Finish to display the report.

Once the report appears, you can print it, export its contents to a delimited text file (CSV) or a Microsoft Excel 
workbook, or save it to the Historical Report tab.

Table 1-1: Quality reports

Report name Description

Failure Trend Identifies trends in failure modes over time. Based on the results, you can focus corrective efforts 
on those items that have the greatest effect on product quality. To produce a report of the 
quantities affected during the specified time period, product service requests must have a value 
specified in the Affected Items.Quantity Affected field.

Quality Activity Lists all the quality incidents (product service requests and quality change requests) that were 
processed during a specified period

Quality Backlog Counts the quality incidents (product service requests and quality change requests) that were at a 
specified status but have not moved to another specified status during a specified time period.

Quality Cycle Time Calculates the time it took the specified product service requests and quality change requests (PSRs 
and QCRs) to move from one status to another during the specified period.

The report lists the requests and shows the average time each PSR or QCR spent between two 
statuses per time period. For example, the report indicates the average time it took for a PSR or 
QCR to go from Submitted to Released each month during the last year, grouped by a product line.

Quality Metrics Shows the quality incidents (product service requests and quality change requests) that were 
moved to a specified status during a specified period.
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Quality Tracking Tabs and Fields for Other Objects
Quality information on certain tabs and fields is linked with information about objects such as items, customers, and 
suppliers so that users in your organization can assess the quality risk of incorporating certain parts into their 
designs. 

❑ The Quality tab for items displays all PSRs reported against that item.

❑ The Quality tab for items displays the QCR number.

❑ On the PSRs tab of a customer object, all quality incidents ever reported by a customer are listed. This can help 
you gauge customer satisfaction.

❑ On the PSRs tab of a supplier object, all quality incidents ever filed against the supplier are listed. This can affect 
purchasing by helping you gauge the quality performance of a supplier so that you can establish a rating or 
preference for that supplier.

Getting Started with Agile PLM
Product Quality Management is one of several Agile PLM solutions. It takes advantage of Agile PLM features that 
are shared among all the solutions. For information on how to use common Agile PLM features, see Getting Started 
with Agile PLM. That manual provides details on how to 

❑ create and manage customers and suppliers

❑ work with standard reports

❑ work with attachments

❑ use the Relationships tab

❑ manage workflows and audits

❑ create and run searches
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CHAPTER 2
Product Service Requests

This chapter covers how to create and work with product service requests (PSRs), which include problem 
reports and non-conformance reports. It has the following sections:
❑ Creating a PSR
❑ Creating a PSR from Items
❑ Completing and Editing PSRs
❑ Submitting and Routing PSRs

Creating a PSR 
You can create problem service requests (PSRs) in various ways, depending on the quality incidents. Here are two 
examples:

❑ Creating a PSR to report a single quality incident — Suppose you are a quality analyst working at a computer 
manufacturing division. A customer calls to report a problem about a CD drive not opening so she can insert and 
remove CDs. You create a quality incident for this problem specific to CD drive item (and its related parts and 
documents) and want the QA department to quickly look at this incident to see if it is in fact a defect or merely 
user error.

The following diagram illustrates the flow: 

❑ Creating a PSR to aggregate multiple PSRs — Suppose you are a quality assurance engineer for a certain product. 
Recently, you’ve noticed several incoming lots and shipments from your suppliers that do not conform to the 
material specifications.   You decide to track down all these incidents and create one single PSR to aggregate all 
suppliers’ incidents. 

Customer 1
Create a problem 
report and add 
affected items

Route the problem 
report through 
workflow

Notify 
Customer 1

Resolve the 
problem

Reports problem
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The following diagram illustrates the flow: 

Creating a PSR to Report a Single Quality Incident 

If there is a problem in a specific item, part, or document that leads to a single quality incident, you create a PSR and 
add those items on the Affected Items tab. Then, if necessary, you can route the PSR through a workflow to investigate 
the quality incident and to resolve the problem. 

You must have the necessary privileges to create a PSR object. A PSR object is created the same way other Agile PLM 
objects are created. You can use the New Object button or the Save As feature. 

To create a PSR to report a single quality incident in Java Client:

1 On the main toolbar, click the New Object button . The New dialog box appears.

2 Select NCR or Problem Report from the Type list.

3 In the Number field, accept the default number. Or you can type a number or click the AutoNumber button  to 
automatically enter the next number. Click OK. The Cover Page tab is displayed. 

4 Enter the required information on the Cover Page tab, and click Save. For information about the fields on this tab, 
see “Cover Page Tab” on page 2-6.

Agile Java Client creates the PSR and displays the PSR with the Cover Page tab on top. If a workflow is not assigned 
to a PSR then the created PSR will have the Unassigned status. To assign a workflow, select a workflow from the 
Workflow drop-down list. 

5 Click the Affected Items tab, and click the Add button to add items as required. The Select Objects dialog box 
appears. Either select Create New Object to create a new item, or specify search conditions and then click OK to search 
for an existing item.

You can add multiple items. For a single PSR, multiple items (for example, different parts, documents, 
assemblies) might need resolution. For more information about adding items to the Affected Items tab, see “Adding 
Affected Items” on page 2-9.

Note Depending on your system’s SmartRule settings, the Related PSR tab may be disabled after you add items to 
the Affected Items tab.

To create a PSR to report a single quality incident in Web Client:

1 From the main toolbar, choose Create > Product Service Request > Problem Reports or Non-Conformance Reports.

2 When the PSR Reports Creation wizard opens, select a subclass from the list.

3 In the Number field, accept the default number. Or you can type a number or click the AutoNumber button  to 
automatically enter the next number. Click Next. The Enter Cover Page Information page appears.
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all problems reports 
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Route parent 
problem report 
through workflow

Notify all 
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Resolve the 
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4 Enter the required information. For information about the fields on this tab, see “Cover Page Tab” on page 2-6. 
You can assign a workflow to route the PSR through the workflow statuses. Click Next. The Add Affected Items 
page appears.

5 Click the Add button to add items. The Add Affected Items Wizard appears. You can add multiple items. For a 
single PSR, multiple items (for example: different parts, document, assembly) might need resolution.

6 Either select Create to create a new item, or specify search conditions to search for an existing item. Click Next.

7 If you searched for existing items, select one or more from the results, and click Next. If you chose to create a new 
item, type the item number and click Next.

The Information page of the Add Affected Items Wizard appears. 

8 Complete the appropriate fields. You can specify the Rev Found, Affected Site, Failure Mode and Quantity Affected. Click 
Finish. The Add Affected Items page reappears. 

9 You can click Finish, or click Next to add attachments. 

10 On the Add Attachments page, click the Add button to add attachments if necessary.

11 Click Finish.

Agile Web Client creates the PSR and displays it with the Cover Page tab on top. If a workflow is not assigned to 
the PSR, the status is Unassigned. To assign a workflow, click the Edit button on the Cover Page and select a 
workflow from the Workflow drop-down list.

Note Depending on your system’s SmartRule settings, the Related PSR tab may be disabled after you add items to 
the Affected Items tab.

Creating a PSR Using Save As

You can use Save As to create a PSR. Save As copies data from a field in the existing object to the same field in the 
new object. If a field or list value in the existing object is not available in the new object, then that field or list value 
is not copied to the new object.

Caution! In general, you should not use Save As to create an object in a different class or subclass from the original 
object. The different classes or subclasses may not have the same tabs or defined fields, and you may lose 
access to some data in the newly created object. 

Because Page Three data applies to a specific subclass only, if you use Save As to create a new object of a 
different subclass, the Page Three data is not copied to the new object.

To create a PSR using Save As in Java Client:

1 Open the PSR you want to use as the basis for a new PSR. Choose File > Save As, or right-click and choose Save As. 
The Save As dialog box appears. 

2 Select NCR or Problem Report from the Type list.

3 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

4 Click OK.

Agile Java Client creates the PSR and displays the PSR with the Cover Page tab on top. 

5 Make any appropriate modifications to the tabs, and click Save.

To create a PSR using Save As in Web Client:   

1 Open the PSR you want to use as the basis for a new PSR.

2 Choose Actions > Save As. The Save As page appears.

3 Select NCR or Problem Report from the Type list.
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4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

5 Click Save. The new object opens.

6 Make any appropriate modifications to the tabs, and click Save.

The following fields are copied to the new PSR:

If the Agile PLM administrator has set the appropriate preferences, fields in the optional Page Two and Page Three 
sections are copied to the new PSR. For information about the behavior of Page Two and Page Three fields in your 
Agile PLM system, see your Agile PLM administrator. 

Creating a PSR to Aggregate Multiple PSRs 

You might have created a number of PSRs to deal with multiple problems. You might discover that, if a particular 
problem is solved, all the related problems for which you have created PSRs would also be resolved. You can 
aggregate other related PSRs that have already been created. The PSR you create to solve the related PSRs is 
considered the parent PSR, and all the added PSRs on the Related PSR tab are considered child PSRs. 

To create a PSR to aggregate multiple PSRs in Java Client:

1 Follow steps 1 through 4 on page 2-2 for creating a PSR in Java Client.On the Affected Items tab, do not add any 
items. On the Related PSR tab, add all the related PSRs. After you add related PSRs to this parent PSR, on the Cover 
Page of the child PSRs, the Aggregate PSR Number field is automatically filled in with this parent PSR number. 

Click to select the related PSR, and click the Edit Product Service Request button. The Edit Product Service Request 
dialog box appears. Specify the PSR Event and PSR Result statuses as shown in Table 2-2. Click OK.

Note Depending on your system’s SmartRule settings, the Affected Items tab may be disabled after you add related 
PSRs.

Table 2-1: Fields copied using Save As 

Fields copied from old object Automatically generated fields

Category, PSR Type, Problem Description, Severity, Product Line(s) Originator

Page 2 and Page 3 flex fields Date Originated

All item information is copied from the Affected Items tab Status field is set to Unassigned by default

All attachments are copied from the Attachments tab

History tab reflects the source and target objects

Table 2-2: Fields in the Edit Product Service Request dialog box

Field Completed... Contains...

<PSR#> PSR Event Manually. The status of the parent PSR that triggers an automated workflow event. 
Select an available status from the drop-down list. You can specify the status only 
when the PSR has a workflow assigned. When this event occurs, it means that this 
PSR has reached the specified status.

Note You can specify the PSR Event status only when both objects (parent 
and child) are assigned a workflow on the Cover Page tab.

PSR Result Manually. The status to which the related PSRs are promoted when the event status is 
reached. Select an available status from the drop-down list. You can specify the 
status only when the PSR has a workflow assigned.

When the parent PSR reaches the status in the PSR Event field, then the status of 
the related PSR is automatically moved to the specified result status in this field.

Note You can specify the PSR Result status only when both objects (parent 
and child) are assigned a workflow on the Cover Page tab.
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To create a PSR to aggregate multiple PSRs in Web Client:

1 Follow steps 1 through 4 on page 2-3 for creating a PSR in Web Client.

2 On the Add Affected Items page, do not add any items. Click Next.

3 On the Add Related Product Service Requests page, click Add to add all the related PSRs. After you add related 
PSRs to this parent PSR, the Aggregate PSR Number column for each PSR on the Related PSR tab displays the number 
of the parent PSR. On the Cover Page of the child PSRs, the Aggregate PSR Number field is automatically filled in by 
this parent PSR number.

Note Depending on your system’s SmartRule settings, the Affected Items tab may be disabled after you add related 
PSRs.

4 Click Finish.

Agile Web Client creates the PSR and displays it with the Cover Page tab on top. 

Creating a PSR from Items 
You can create a PSR from an item.

To create a PSR from an item in Java Client:

1 Open the item for which you want to create a PSR.

2 Right-click in the item window, and choose Create Product Service Request from the shortcut menu. The Create 
Product Service Request dialog box appears. 

3 Select NCR or Problem Report from the Type drop-down list. 

4 In the Number field, accept the default number. Or you can type a number or click the AutoNumber button  to 
automatically enter the next number. Click OK. The Cover Page tab is displayed. 

5 Enter the required information on the Cover Page tab, and click Save. For information about the fields on this tab, 
see “Cover Page Tab” on page 2-6.

Agile Java Client creates the PSR and displays it with the Cover Page tab on top. The item appears on the Affected 
Items tab of the new PSR.

To create a PSR from an item in Web Client:

1 Open the item for which you want to create a PSR.

2 On the item page, choose Actions > Create Product Service Request. The Product Service Request Creation Wizard 
appears.

3 Select a subclass (Problem Report or NCR) from the list.

4 In the Number field, accept the default number. Or you can type a number or click the AutoNumber button  to 
automatically enter the next number. Click Next. The Enter Cover Page Information page appears.

5 Enter the required information. For information about the fields on this tab, see “Cover Page Tab” on page 2-6. 
You can assign a workflow to route the PSR through the workflow statuses. If you need to add additional items, 
click Next. The Add Affected Items page appears. Or click Finish.

Agile Web Client creates the PSR and displays it with the Cover Page tab on top. The item appears on the Affected 
Items tab of the new PSR.

Completing and Editing PSRs
After you have created a problem report or non-conformance report, you can edit the report to provide additional 
information you did not include when you created it. You can also edit any information that has changed since the 
PSR was created. 
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The following sections provide information about working with the tabs for product service requests.

Cover Page Tab

The following table lists and describes the fields on the PSR Cover Page tab.

Table 2-3: PSR Cover Page tab fields

Field Completed... Contains...

Number Automatically, when created. The number assigned to the PSR when you create it.

For a problem report, the number is prefixed with PR.

For non-conformance report, the number is prefixed with NCR.

PSR Type Automatically, when created. The type (subclass) selected when you create the QCR. 

Category Manually. Drop-down list of categories defined by the Agile PLM 
administrator, for example: 

Customer Complaint
Audit - External
Preventive Action

Description Usually manually; can contain a 
default.

Maximum number of bytes is set by the Agile PLM administrator; 
can be up to 1023 bytes, including spaces and carriage returns 
(which count as two bytes).

Customer Manually. The customer associated with this PSR.

Supplier Manually. List of suppliers who initiated the incident or are the cause of the 
incident.

Severity Manually. Drop-down list of severities defined by the Agile PLM administrator. 

Disposition Manually. Drop-down list of dispositions defined by the Agile PLM 
administrator.

The Disposition field displays a code that represents the way in which 
a PSR is being resolved. Examples of dispositions are Replace 
Component and Rework to Spec. 

Expected 
Resolution Date

Manually. Expected problem resolution date. 

Quality Analyst May be provided automatically by 
the workflow; otherwise selected 
manually from a drop-down list. 
Departments appear first in the list, 
followed by individual user names. 

The default quality analyst.
If the workflow is defined to notify the default quality analyst, the 
department or user in this field receives notifications about the PSR. 
If this field is left blank, then the notifications are sent to every 
quality analyst on the list. If the notification definition in the 
workflow is blank, no notifications are sent.

Workflow If more than one workflow applies 
to the PSR, the workflow is selected 
manually; the workflow selection 
can be changed as long as the PSR is 
in the Pending type status. Selecting 
the blank field in the Workflow drop-
down list switches the PSR to the 
Unassigned status.

If no workflow is assigned, and you 
move the PSR to the next status 
from the Unassigned status, you are 
prompted to select a workflow.

The name of the workflow being used to move this PSR through the 
quality tracking process.

Status Automatically, when created; 
updated as the PSR moves through 
the assigned workflow.

Workflow status. If no workflow has been selected, this field is 
Unassigned.

Originator Automatically, when created. The default creator of the PSR. Drop-down list of other problem 
report originators.
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Affected Items Tab

The Affected Items tab lists of all items that are affected by the current PSR. A single PSR can affect multiple items 
(for example, parts, documents). 

Note You can add affected items only if the PSR has not reached the Released status of the workflow.

You can edit any information that has changed since the PSR was created. You might also need to add additional 
items (for example, different parts, documents, assemblies) that need resolution.

The Affected Items table has the following columns by default.

Date Originated Usually automatically, when 
created.

The date the PSR was created.

Date Submitted Automatically generated based on 
workflow status.

The date when the PSR moves to the Submitted status in the 
workflow. 

Date Released Automatically generated based on 
workflow status.

The date when the PSR moves to the first Released status in the 
workflow.

Final Complete 
Date

Automatically generated based on 
workflow status.

The date when the PSR moves to the Complete status in workflow.

Aggregate PSR 
Number 

Automatically filled in when PSR(s) 
are added to the Related PSR tab. 

For example, if PSR005 lists PSR003 
and PSR004 on the Related PSR tab, 
then on the Cover Page tab of 
PSR003 and PSR004, PSR005, the 
parent, will appear in the Aggregate 
PSR Number field.

This number is automatically filled in with the parent PSR number. 

For example: For a single problem, many quality incidents from 
your suppliers are already created. You decide to track down all these 
incidents and create one single PSR (parent PSR) to aggregate all 
suppliers’ incidents. 

You can also set the result status of all related PSRs to change 
automatically when the aggregate PSR reaches a specific status. 

Product Line(s) Manually. The product lines this PSR affects.

Table 2-4: Affected Items tab fields

Field Completed... Contains...

Item Number Automatically, when created. Number of the affected item.

Item Description Automatically, when created. Description of the item.

Rev Found Manually. The revision of the affected item in which the problem is found. For 
example, if the item has undergone five revisions, and this defect is 
identified in revision B, then the Rev Found field displays B.

In Web Client, when you select an item to add, all revisions of the item 
appear in the drop-down list with the latest released revision shown by 
default. You can select to report on this current revision or an older 
revision of the item (for incidents associated with parts that are no longer 
used in latest models) or pending revisions of the item. 
Note: You can add multiple copies of an item at the same revision to the 
Affected Items tab.

Affected Site Automatically, when created. The site at which the affected items are having problems.

Failure Mode Manually Displays the way in which a product failed or did not meet customer 
requirements. You select the failure mode from a list defined by the Agile 
PLM administrator. Lists of failure modes can be defined for each subclass 
of an item. For example, a failure mode for a battery might be No Charge, 
and a failure mode for a power strip might be Blown Fuse.

Table 2-3: PSR Cover Page tab fields (continued)

Field Completed... Contains...
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Rev Fixed and Latest Change Fields

In the following scenarios the Rev Fixed and Latest Change fields are updated. 

Scenario 1

A problem report is filed on a defective assembly Revision C. A corrective action is initiated to investigate the 
defective assembly. A deviation is immediately created that specifies the replacement of the faulty component. In this 
case, the Latest Change field will be updated with the number of the deviation. 

After the root cause is identified, an engineering change order is created that will specify the permanent replacement 
of the defective component in the assembly, which will roll it to Revision D.

In the problem report, the Rev Fixed field will display Rev D, and the Latest Change field will display the ECO number.

Scenario 2

A problem report is filed on a critical device that is causing lots of failures in the field and is deemed unusable. 

An immediate stop ship is ordered that specifies the severity of the problem. In this case, the Latest Change field in the 
problem report is updated to the stop ship number. 

If at a later time a permanent change is implemented through an ECO, then the Rev Fixed and Latest Change fields are 
updated according to the details of the ECO.

For standalone PSRs, the following cases are applied to update the Latest Change and Rev Fixed fields:

❑ If PSRs are not aggregated into a QCR, you can manually update the Rev Fixed field, which will automatically fill 
in the Latest Change field. 

❑ If you manually overwrite the Rev Fixed field, but at a later time, a change is associated with this item, the Rev Fixed 
and Latest Change fields are still filled in automatically. 

For example, the Rev Fixed field for an item is A, and the Latest Change field is ECO10. Then another change is 
released, and the Latest Change field for the item is updated to ECO20. Now, if you manually select A in the Rev 
Fixed field, the Latest Change is automatically updated back to ECO10.

❑ Rev Fixed must always be later than Rev Found. If you specify a Rev Fixed date that is earlier than the Rev Found 
date, an error message appears. 

❑ If Rev Fixed is filled in as the result of releasing the change, unreleasing the change encloses the Rev Fixed value in 
brackets.

Quantity Affected Manually The number of items that were affected by the quality incident.

Rev Fixed Automatically, when 
problem is fixed in the 
revision. It can also be 
changed manually.

The revision of the item in which the problem is fixed. This field can be 
automatically populated when a related ECO is released, or it can be 
manually updated.

Latest Change Automatically, when 
problem is fixed in the 
revision.

The change number of the most recently released change, which is related 
to this PSR’s affected items.

Table 2-4: Affected Items tab fields (continued)

Field Completed... Contains...
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Failure Mode Field

The Failure Mode field displays the way in which a product failed or did not meet customer requirements. You select 
the failure mode from a list defined by the Agile PLM administrator. Lists of failure modes can be defined for each 
subclass of an item. For example, a failure mode for a battery might be No Charge, and a failure mode for a power 
strip might be Blown Fuse.

Information about failure modes can be used in data analysis.

For information about defining failure modes, see the Agile PLM Administrator Guide.

NCR Affected Items Attributes

The attributes and operations of NCRs are similar to those of problem reports except for a few fields on the Affected 
Items tab, which are explained below. 

The following table lists fields that are used in addition to the fields used in problem reports. These fields provide 
additional information about deviations in one or more products. This is part of the process in which the quality 
assurance team examines incoming materials from a supplier shipment. 

Adding Affected Items

You can add items to the Affected Items tab of a PSR.

Note An Agile PLM SmartRule named Many Items per PSR determines whether you can add multiple items to the 
Affected Items tab of a PSR. If Many Items per PSR is set to “Allow,” you can add more than one item to the PSR. 
Otherwise, you can add only one item (one row) to the PSR.

Table 2-5: NCR Affected Items tab fields

Field Completed... Contains...

Conformance 
Specification

Manually. Information about what the material should be, according to the engineering 
specifications.

Serial/Lot Number Manually. Serial number or lot number of the items. 

If there are problems, enter the serial or lot number of the batch that was defective (this 
is similar to the unique identifier for the batch of goods).

Total Quantity 
Suspect

Manually. Total quantity of items suspected of problems. 

If the shipment had problems based on the sample inspection, enter the total number of 
units that were suspected of having problems. 

For example, you receive a lot of 500 units and you inspect 20 units and find that 5 are 
defective:

• 500 total suspect
• 20 checked
• 5 affected

Quantity Checked Manually. The number of items that were checked. 

Quantity Affected Manually. The actual number of items that had problems. 

Containment 
Actions

Manually. Containment actions taken to immediately dispose of the material.

For example, scrap all materials, send back to supplier, mark the bad batches.

RMA Number Manually. Return merchandise authorization. This is the number from the supplier that authorizes 
you to send the defective materials back to the source; it is usually a slip of paper.

Conforming 
Material Date

Manually. The date when the supplier expects to be able to send materials that do conform to the 
specifications.
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To add affected items to a PSR in Java Client:

1 Open the PSR you want to work with, and click the Affected Items tab. 

2 Click the Add drop-down menu button and choose one of the following options: Create, Search, or Type-in Known 
Number(s). 

3 Depending on your menu selection, do one of the following:

• Create – Select a type from the Type drop-down list. If appropriate, enter an object number and a description. 
Click OK.

• Search – Search for one or more existing items. In the Add Affected Item dialog box, select a search method. If 
you choose to perform a simple search, enter the value to search for and click Search. You can also define an 
advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). If you want 
to select different revisions of items or edit other fields, make sure the Edit Rows After Adding box is checked. In 
the search results, select the items you want, and click OK. All items in the Selected Affected Item(s) list are 
added to the Affected Items table.

• Type-in Known Number(s) – enter one or more numbers on separate rows, and click Add.

Note If you click the Add button once without selecting an option from the drop-down list, the Type-in Known 
Number(s) dialog box appears.

To add affected items to a PSR in Web Client:

1 Open the PSR you want to work with, and click the Affected Items tab. 

2 Click the Add drop-down menu button and choose one of the following options: Create New, Search, or Type-in Known 
Number(s). 

3 Depending on your menu selection, do one of the following:

• Create New – Select a type from the Type drop-down list. If appropriate, enter an object number and a 
description. Click OK.

• Search – Search for one or more existing items. In the Add Affected Item dialog box, select a search method. If 
you choose to perform a simple search, enter the value to search for and click Search. You can also define an 
advanced search, run a saved search, or select a bookmarked or recently visited item (Shortcuts). If you want 
to select different revisions of items or edit other fields, make sure the Edit Rows After Adding box is checked. In 
the search results, select the items you want, and click OK. All items in the Selected Affected Item(s) list are 
added to the Affected Items table.

• Type-in Known Number(s) – enter one or more numbers on separate rows, and click Add.

Note If you click the Add button once without selecting an option from the drop-down list, the Type-in Known 
Number(s) dialog box appears.

Editing and Removing Affected Items

If you have the appropriate privileges, you can edit or remove items on the Affected Items tab.

To edit an affected item in Java Client:

1 Open the PSR you want to work with, and click the Affected Items tab.

2 Click the item row you want to edit, and click the Edit Affected Items button. The Edit Affected Items dialog box 
appears.

3 In the editable fields, enter text or use the drop-down lists. For information about the fields on this tab, see 
“Affected Items Tab” on page 2-7.

Note If you manually update the Rev Fixed field, then the Latest Change field is automatically populated with the 
ECO related to that revision change. The Rev Fixed drop-down list contains all revisions for the item.

For example, you can manually update the Rev Fixed field in the following cases:
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• A quality incident is submitted, and a known fix has already been released or implemented. In this case, you 
simply update the Rev Fixed field to account for the fact that this problem was already addressed and corrected 
in that particular revision.

• Update a PSR that does not have a parent and that is not associated with a change or QCR.

4 When you are finished, click OK.

To edit an affected item in Web Client:

1 Open the PSR you want to work with, and click the Affected Items tab. 

2 Select the checkbox for the item you want to edit, and click the Edit button.

3 In the editable fields, enter text or use the drop-down lists. For information about the fields on this tab, see 
“Affected Items Tab” on page 2-7.

Note If you manually update the Rev Fixed field, then the Latest Change field is automatically populated with the 
ECO related to that revision change. The Rev Fixed drop-down list contains all revisions for the item.

For example, you can manually update the Rev Fixed field in the following cases:

• A quality incident is submitted, and a known fix has already been released or implemented. In this case, you 
simply update the Rev Fixed field to account for the fact that this problem was already addressed and corrected 
in that particular revision.

• Update a PSR that does not have a parent and that is not associated with a change or QCR.

4 When you are finished editing, click Save.

To remove affected items in Java Client:

1 Open the PSR you want to work with, and click the Affected Items tab. 

2 Click in one or more rows to select the items you want to delete.

3 Click the Remove button.

The selected items are removed from the Affected Items tab after confirmation. 

To remove affected items in Web Client:

1 Open the PSR you want to work with, and click the Affected Items tab. 

2 Select one or more checkboxes for the items you want to delete. 

3 Click the Remove button.

The selected items are removed from the Affected Items tab after confirmation. 

Related PSR Tab

The Related PSR tab contains a list of all PSRs that are aggregated into the current PSR. The current PSR is considered 
the parent PSR. Once you have created a PSR, you can edit information about related PSRs. You can also aggregate 
related PSRs into this PSR (the parent).

For example, say that multiple customers have reported similar kind of problems, and for each customer problem, 
a problem report has already been created. The quality team has determined that different customers’ problems are 
all related and can be solved with one solution. To provide a solution and resolve all the related PSRs, the quality 
team creates one PSR (parent) and adds (aggregates) all the related PSRs to the parent PSR. 
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The Related PSR table has the following columns by default.

Table 2-6: Related PSR tab fields

Field Completed... Contains...

PSR Criteria Met Automatically, when the PSR 
event criteria is met.

Indicates when the PSR event occurred (that is, the parent PSR has 
reached the status selected for the PSR event).

Once the parent PSR attains the status specified in the PSR Event field, 
then the related PSR status automatically moves to the status specified 
in the PSR Result field and completes the criteria specified. Once a 
criterion is met, the symbol completed is displayed.

<PSR#> PSR Event Manually. The status of the parent PSR that triggers an automated workflow 
event. 
Select an available status from the drop-down list. You can specify the 
status only when the PSR has a workflow assigned. When this event 
occurs, it means that the PSR has reached the specified status.
The default value of the PSR Event is set to the Closed status. If you have 
Quality Analyst privileges, you can set the default value to another 
status in Java Client. For details, see “Relationships Tab” on page 2-15. 

Note You can specify the PSR Event status only when both objects 
(parent and child) are assigned a workflow on the Cover Page 
tab.

PSR Result Manually. The status to which the related PSRs are promoted when the event 
status is reached. Select an available status from the drop-down list. 
You can specify the status only when the PSR has a workflow assigned.

When the parent PSR reaches the status in the PSR Event field, then the 
status of the related PSR is automatically moved to the specified result 
status in this field.
The default value of the PSR Result is set to the Closed status. If you 
have Quality Analyst privileges, you can set the default value to another 
status in Java Client. For details, see “Relationships Tab” on page 2-15.

Note You can specify the PSR Result status only when both 
objects (parent and child) are assigned a workflow on the 
Cover Page tab.

PSR Type Automatically. The type of related PSR.

PSR Number Manually, when a related PSR 
is added.

The related PSR number.

PSR Category Automatically. The quality incident category of the related PSR. 

PSR Description Automatically. Description of the related PSR. 

PSR Customer Automatically. The customer associated with the related PSR.

PSR Supplier Automatically. The supplier associated with the related PSR.

PSR Severity Automatically. The severity of the related PSR. Severities are defined by the Agile PLM 
administrator. 

PSR Disposition Automatically. The way this PSR was resolved.

PSR Expected 
Resolution Date

Automatically. The related PSR expected problem resolution date.

PSR Quality Analyst Automatically. The quality analyst assigned to the related PSR. 

If the workflow is defined to notify the default quality analyst, the 
department or user in this field receives notifications about the PSR. 

PSR Workflow Automatically. The name of the workflow being used to move this PSR through the 
quality tracking process.

PSR Status Automatically. The related PSR workflow status. If no workflow has been selected, this 
field is Unassigned.

PSR Originator Automatically, when created. The default creator of the PSR. 
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PSR Event and PSR Result Fields

When you add a PSR, you can also complete the PSR Event and PSR Result fields. The PSR Event field is used to specify 
the status of the parent PSR that triggers the PSR result. The PSR Result field is used to specify the status the child PSR 
moves to automatically once the parent PSR moves to the status specified in the PSR Event field. Once the parent PSR 
moves to the status specified in the PSR Event field, all related PSRs are automatically moved to statuses specified in 
the PSR Result field. 

For example, the quality manager creates problem report PR00444 and adds all related problem reports PR00331, 
PR00332 and PR00333. When adding PR00331, the quality manager specifies that the PSR Event status is Released 
and the PSR Result is Closed. In this case, as soon as the parent PSR PR00444 is moved to the Released status, 
PR00331 is moved automatically to the Closed status, and in the PSR Criteria Met column, the Completed symbol 
is displayed.

You don’t have to manually close each individual related PSR. Because related PSRs are closed automatically, your 
quality control process is handled efficiently. 

Note You can specify a status in the PSR Event and PSR Result fields only when both objects (parent and child) are 
assigned a workflow on the Cover Page tab.

Adding Related PSRs

You can add related PSRs to a parent PSR.

After you add related PSRs to the parent PSR, the Aggregate PSR Number column for each PSR on the Related PSR tab 
displays the number of the parent PSR. On the Cover Page of the child PSRs, the Aggregate PSR Number field is 
automatically filled in by the parent PSR number.

To add related PSRs to the parent PSR in Java Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

2 Click the Add drop-down menu button and choose one of the following options: Create or Search.

3 Depending on your menu selection, do one of the following:

• Create – Select a type from the Type drop-down list. If appropriate, enter an object number. Click OK.

• Search – Search for one or more existing PSRs. In the Add Related PSR(s) dialog box, select a search method. 
If you choose to perform a simple search, enter the value to search for and click Search. You can also define an 
advanced search, run a saved search, or select a bookmarked or recently visited PSR (Shortcuts). If you want 
to edit fields after adding related PSRs, make sure the Edit Rows After Adding box is checked. In the search results, 
select the PSRs you want, and click OK. All PSRs in the Selected Related PSR(s) list are added to the Related PSR 
table.

PSR Date Originated Usually automatically, when 
created.

The date the related PSR was created.

PSR Date Submitted Usually automatically, when 
created.

The date the related PSR was submitted.

PSR Date Released Usually automatically, when 
created.

The date the related PSR was released.

PSR Final Complete 
Date

Usually automatically, when 
created.

The date the related PSR was completed.

Aggregate PSR Number Automatically filled in when 
PSR(s) are added to the 
Related PSR tab. 

This field is automatically filled in with the parent PSR number. 

Table 2-6: Related PSR tab fields (continued)

Field Completed... Contains...
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Note If you click the Add button once without selecting an option from the drop-down list, the Add Related 
PSR(s) (Search) dialog box appears.

To add related PSRs to the parent PSR in Web Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

2 Click the Add drop-down menu button and choose one of the following options: Create New or Search.

3 Depending on your menu selection, do one of the following:

• Create New – Select a type from the Type drop-down list. If appropriate, enter an object number. Click OK.

• Search – Search for one or more existing PSRs. In the Add Related PSR(s) dialog box, select a search method. 
If you choose to perform a simple search, enter the value to search for and click Search. You can also define an 
advanced search, run a saved search, or select a bookmarked or recently visited PSR (Shortcuts). If you want 
to edit fields after adding related PSRs, make sure the Edit Rows After Adding box is checked. In the search results, 
select the PSRs you want, and click OK. All PSRs in the Selected Related PSR(s) list are added to the Related PSR 
table.

Note If you click the Add button once without selecting an option from the drop-down list, the Add Related 
PSR(s) (Search) dialog box appears.

Editing and Removing Related PSRs

If you have the appropriate privileges, you can edit and remove related PSRs.

To edit related PSRs in Java Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

2 Select the PSR row you want to edit, and click the Edit button.

3 In the editable fields, enter text or use the drop-down lists. The PSR Event drop-down list shows the available 
statuses of the parent PSR. You can select statuses for the parent and the related PSR so that when the parent PSR 
reaches the status in the PSR Event field, the related PSR moves to the status in the PSR Result field. For example, if 
you set the PSR Event field to Closed and the PSR Result field to Closed, once the parent PSR reaches the Closed 
status, the related (child) PSR moves automatically to the Closed status.

Note By default the PSR Event and PSR Result fields display the Closed status, but you can select the required status 
from drop-down list. The PSR Event and PSR Result drop-down lists are empty if no workflow is assigned for 
either parent or child PSRs.

4 When you are finished, click OK.

To edit related PSRs in Web Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

2 Select one or more checkboxes for the related PSRs you want to edit, and click Edit. 

3 The PSR Event drop-down list shows the available statuses of the parent PSR. You can select statuses for the parent 
and the related PSR so that when the parent PSR reaches the status in the PSR Event field, the related PSR moves 
to the status in the PSR Result field. For example, if you set the PSR Event field to Closed and the PSR Result field to 
Closed, once the parent PSR reaches the Closed status, the related (child) PSR moves automatically to the Closed 
status. 

Note By default the PSR Event and PSR Result fields display the Closed status, but you can select the required status 
from drop-down list. The PSR Event and PSR Result drop-down lists are empty if no workflow is assigned for 
either parent or child PSRs.

4 When you are finished, click OK.
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To remove a related PSR in Java Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

2 Click in the row to select the related PSR you want to delete.

3 Click the Remove  button.

The selected PSR is removed from the Related PSR tab after confirmation. The number of the parent PSR is removed 
from Aggregate PSR Number field on the Cover Page of the child PSR.

To remove a related PSR in Web Client:

1 Open the PSR you want to work with, and click the Related PSR tab. 

1 Select the checkbox for the related PSR you want to delete.

2 Click the Remove button.

The selected PSR is removed from the Related PSR tab after confirmation. The number of the parent PSR is removed 
from the Aggregate PSR Number field on the Cover Page of the child PSR.

Relationships Tab

The Relationships tab allows you to create relationships and dependencies between this PSR and other routable objects 
and lifecycle objects. The Affected By table lists objects whose workflow status or lifecycle phase affects the workflow 
progression of the current PSR. The workflow progression of the PSR affects the workflow progression of the objects 
listed in the Affects table.

You use the Relationships tab to establish relationships between objects and to set up automated workflow triggers that 
determine how Agile PLM objects affect each other. For example:

1 A QCR is affected by a change. When a change is released, it automatically moves the QCR to the Validate status 
so that quality assurance can test and verify that the fix does in fact address the initially reported problem.

2 Once quality assurance verifies this, the QCR can move from the Validate to the Closed status. When the QCR 
is closed, it automatically closes the initial PSR, indicating that a fix has been identified, implemented, and 
verified. 

You create such a relationship when you add an object to the Relationships tab of another object. Classes of objects 
that can be referenced on a Relationships tab include routable objects (changes, PSRs, QCRs, programs), items, 
manufacturers, manufacturer parts, suppliers, customers, projects, RFQs, prices, and discussions.

When PSRs are added to the Affects table on the Relationships tab of a QCR, all items from the PSR Affected Items tab 
are displayed on the PSR Items table of the QCR. If the PSR was used to aggregate multiple PSRs, then the first level 
related PSRs’ affected items are displayed.

When this QCR is added to the Affected By table on a PSR Relationships tab, all items from the PSR Affected Items tab 
are copied to the QCR Affected Items tab. 

When a PSR is added to the Affects table of the QCR Relationships tab, the QCR is added to the PSR Affected By table. 
(If the PSR is used to aggregate multiple problems, the QCR is not added to the related PSR’s Affected By table.)

When a QCR is added to a PSR, a check is performed for the Many QCRs per PSR SmartRule. If it is set to “Disallow,” 
then you can add only one QCR. If it is set to “Warning,” when you try to add more than one QCR, a warning 
message is displayed. For details about SmartRules, see the Agile PLM Administrator Guide. 

The Relationships tab contains two tables:

❑ The Affected By table lists objects that affect the current object and what the effects are. For example, a QCR 
might be affected by an ECO. When the status of the ECO changes to Implemented, the QCR status could change 
automatically to Complete.
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❑ The Affects table lists objects that the current object affects, and what the effects are. For example, an ECO might 
affect an ECR. When the status of the ECO changes to Implemented, the ECR status could change automatically 
to Complete.

Note If the PSR is in the Hold or Cancel status, you cannot add objects to the Affects table. Similarly, if a routable 
object is in the Hold or Cancel status, you cannot add it to the PSR.

Affected By Table

The Affected By table lists objects whose workflow status or lifecycle phase affects the workflow progression of the 
PSR. If you add an object and specify a status in the Event field, then the PSR status is affected by the status of the 
added object. For example, if you have added a QCR object with the Validated event status, and the status in the 
Result field is Closed, then when the QCR moves to the Validated status, the current PSR automatically moves to the 
Closed status.

When you create a QCR from a PSR, the newly created QCR is added to the Affected By table of the PSR. You can 
set the event trigger to move the PSR to a specific status in the workflow when the QCR event occurs. For 
information about creating QCRs from PSRs, see “Creating a QCR from a PSR or an Item” on page 3-3.

The Affected By table has the following columns by default.

Table 2-7: Relationships tab Affected By table fields

Field Completed... Contains...

Criteria Met Icon Automatically, when 
the added object 
event criteria is met.

Indicates when the added object event occurred. Once the added object 
attains the status specified in the Event field, then this PSR status 
automatically moves to the status specified in the PSR Result field and 
completes the criteria specified. Once a criterion is met, the Criteria Met icon 
is displayed.

Type (Image) Automatically. The type of the added object.

Number Automatically. The number of the added object. You can add items (parts, documents), 
changes, manufacturers, manufacturer parts, customers, sourcing projects, 
RFQs, suppliers, PE-related objects, discussions. 

Description Automatically. The description of the added object.

Event Manually, when 
object is added.

The status of the related object that will trigger an automatic workflow event. 
You can select an available status from the drop-down list during creation or 
editing. 
When this event occurs, the affected-by object will move to the Result status.
The default value of the Event is set to the Closed status. If you have Quality 
Analyst privileges, you can set the default value to another status in Java 
Client. For details, see “Relationships Tab” on page 2-15.

Note You can specify the Event status only when both objects are 
assigned a workflow on the Cover Page.

<PSR> Result Manually, when 
object is added.

The PSR result status. You can select the available status from the drop-down 
list during creation or editing. 
When the added object reaches the status specified in the Event field, then the 
status of the PSR is automatically moved to the status specified in this field. 

The default value of the PSR Result is set to the Closed status. If you have 
Quality Analyst privileges, you can set the default value to another status in 
Java Client. For details, see “Relationships Tab” on page 2-15.

Note You can specify PSR Result status only when both objects are 
assigned a workflow on the Cover Page.

Current Status Automatically. Current status of the added object.
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To add objects to the Affected By table in Java Client:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 Click the Add button  above the Affected By table. The Add Related Objects dialog box appears.

You can add all routable objects to the Affected By table. Even though non-routable objects such items, 
manufacturer parts, manufacturers, projects, RFQs, and prices do not have a Relationships tab, you can add them 
to this table. 

3 Search for one or more existing objects.

In the Add Related Objects dialog box, select a search method. If you choose to perform a simple search, enter 
the value to search for and click Search. You can also define an advanced search, run a saved search, or select a 
bookmarked or recently visited objects (Shortcuts). If you want to edit fields after adding related objects, make 
sure the Edit Rows After Adding box is checked. In the search results, select the objects you want, and click OK. All 
objects in the Selected Related Object(s) list are added to the Affected By table.

For example, if you want to close PSR0001 when ECO0001 moves to Implemented status, then you can select 
Implemented in the Event field and Closed in the PSR Result field. Once ECO0001 is moved to Implemented status, 
the PSR automatically moves to Closed status.

Note You can specify the statuses that will appear in the Event and PSR Result fields only when the object is routed 
through a workflow. If there is no workflow assigned for the PSR or for the object you are adding, these 
fields are blank. 

The selected objects are added to the Affected By table on the Relationships tab.

Note When you add an object to the Affected By table of a PSR, the PSR is added to the Affects table on the 
Relationships tab of the object.

To add objects to the Affected By table in Web Client:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 Click the Add button above the Affected By table. The Add Related Content Wizard appears.

3 Search for one or more existing objects.

In the Add Related Content Wizard dialog box, select a search method. If you choose to perform a simple search, 
enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select 
a bookmarked or recently visited objects (Shortcuts). If you want to edit fields after adding related objects, make 
sure the Edit Rows After Adding box is checked. In the search results, select the objects you want, and click OK. All 
objects in the Selected Related Object(s) list are added to the Affected By table.

For example, if you want to close the PSR0001 as soon as the ECO0001 moved to Implemented state, then you 
can select Implemented in the Event field and Closed in the Result field. When ECO0001 moves to the 
Implemented status, the PSR automatically moves to the Closed status. 

Note You can edit the Event and Result fields only when the object is routed through a workflow. If there is no 
workflow assigned for the PSR or for the object you are adding, these fields are blank. 

The selected objects are added to the Affected By table on the Relationships tab.

Note When you add an object to the Affected By table of a PSR, the PSR is added to the Affects table on the 
Relationships tab of the object.

To edit objects in the Affected By table:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 In the Affected By table, select the row you want to edit. Click the Edit button.

3 In the editable fields, enter text or use the drop-down lists.
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4 When you are finished, click OK (Java Client) or Save (Web Client).

Note You can edit the objects in the Affected By table only if you have the appropriate privileges.

To remove objects from the Affected By table:

1 Open the PSR you want to work with, and click the Relationships tab. 

1 Select the object you want to remove.

2 Click the Remove button.

The selected object is removed after confirmation. The PSR is removed from the Affected By table on the 
Relationships tab of the object. 

Affects Table

The workflow progression of a PSR affects the workflow progression of the objects listed in the Affects table. For 
example, if you add a QCR with Closed in the Event field, and specify Implemented in the Result field, when the PSR 
moves to the Closed status, the QCR status automatically changes to Implemented. 

Note You can add only routable objects such as changes to this table. You cannot add objects that have lifecycle 
phases and do not have a Relationships tab, such as items.

Table 2-8: Relationships tab Affects table fields

Field Completed... Contains...

Criteria Met Icon Automatically, when the PSR 
event criteria is met.

Indicates when the PSR event occurred. Once the PSR attains 
the status specified in the PSR Event field, then the related 
object status automatically moves to the status specified in the 
Result field and completes the criteria specified. Once a 
criterion is met, the Criteria Met icon is displayed.

Number Automatically. The number of the added object that is affected by this PSR. You can 
add only routable objects such as changes. You cannot add objects 
with lifecycle phases, such as items.

Description Automatically. The description of the listed object. 

<PSR> Event Manually, when object is 
added.

The workflow status of the current object that affects the workflow 
progression of the PSR. When the PSR moves into the specified status, 
then the listed object enters the status specified in the Result field. 

You can specify PSR Event status only when both objects (parent and 
child) are assigned with a Workflow in Cover Page.

The default value of the PSR Event is set to the Closed status. If you 
have Quality Analyst privileges, you can set the default value to 
another status in Java Client. For details, see “Relationships Tab” on 
page 2-15.

Result Manually, when object is 
added.

The listed object result status. 

When the PSR reaches the status specified in the Event field, the status 
of the listed object is automatically moved to the status specified in 
this field.

You can specify Result status only when both objects (parent and 
child) are assigned with a workflow on the Cover Page.

The default value of the PSR Result is set to the Closed status. If you 
have Quality Analyst privileges, you can set the default value to 
another status in Java Client. For details, see “Relationships Tab” on 
page 2-15.

Current Status Automatically. Current status of the added object.
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To add objects to the Affects table in Java Client:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 Click the Add button  above the Affects table. The Add Related Objects dialog box appears.

You can add only existing change objects, QCRs, programs, and declarations to the Affects table.

3 Search for one or more existing objects.

In the Add Related Objects dialog box, select a search method. If you choose to perform a simple search, enter 
the value to search for and click Search. You can also define an advanced search, run a saved search, or select a 
bookmarked or recently visited objects (Shortcuts). If you want to edit fields after adding related objects, make 
sure the Edit Rows After Adding box is checked. In the search results, select the objects you want, and click OK. All 
objects in the Selected Related Object(s) list are added to the Affects table.

Note You can specify the statuses that will appear in the Event and Result fields only when the object is routed 
through a workflow. If there is no workflow assigned for the PSR or for the object you are adding, these 
fields are unavailable.

The selected objects are added to the Affects table on the Relationships tab.

Note When you add an object to the Affects table of a PSR, the PSR is added to the Affected By table on the 
Relationships tab of the object.

To add objects to the Affects table in Web Client:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 Click the Add button above the Affects table. The Add Related Content Wizard appears.

You can add only change objects, QCRs, programs and declarations to the Affects table.

3 Search for one or more existing objects.

In the Add Related Content Wizard dialog box, select a search method. If you choose to perform a simple search, 
enter the value to search for and click Search. You can also define an advanced search, run a saved search, or select 
a bookmarked or recently visited objects (Shortcuts). If you want to edit fields after adding related objects, make 
sure the Edit Rows After Adding box is checked. In the search results, select the objects you want, and click OK. All 
objects in the Selected Related Object(s) list are added to the Affects table.

Note You can edit the Event and Result fields only when the object is routed through a workflow. If there is no 
workflow assigned for the PSR or for the object you are adding, these fields are unavailable.

The selected objects are added to the Affects table on the Relationships tab.

Note When you add an object to the Affects table of a PSR, the PSR is added to the Affected By table on the 
Relationships tab of the object.

To edit objects in the Affects table:

1 Open the PSR you want to work with, and click the Relationships tab. 

2 In the Affects table, select the row you want to edit. Click the Edit button.

3 In the editable fields, enter text or use the drop-down lists.

4 When you are finished, click OK (Java Client) or Save (Web Client).

Note You can edit the objects in the Affects table only if you have the appropriate privileges.

To remove objects from the Affects table:

1 Select an object from Affects table.

2 Click the Remove button.

The selected object is removed after confirmation. The PSR is removed from the Affects table on the Relationships tab 
of the object. 
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References Tab

The References tab allows you to create references between the current object and other Agile PLM objects. You can 
use references to record objects that are somehow related to the current object, but do not have any dependencies 
with it.

Other than providing a link to the listed object, adding an object to the References tab has no affect on the current 
object or the listed object. References do not trigger events. You can add any existing object as a reference. 

Note If your Agile PLM administrator has disabled the References tab, the tab is not visible.

To add an object to the References tab: 

1 On the References tab, click the Add button. In Java Client, the Add Related Objects dialog box appears. In Web 
Client, the Add Related Content Wizard appears. 

2 Search for one or more objects.

3 In the displayed search results, click to select the objects you want. Click OK.

The selected objects are added to the Reference tab.

Note When you add an object to the References tab of a PSR, the PSR is added to the References tab of the object.

Workflow Tab

The Workflow tab displays a flowchart of the workflow you selected on the Cover Page. An Agile PLM workflow is a 
sequence of statuses that a routable object follows as it goes through the different statuses in the quality control 
process. The status with the orange background (Web Client) or yellow background (Java Client) is the current 
status. The Signoff History table displays past workflow and signoff information for the PSR. 

For example, a PSR can be routed internally for preliminary investigation, or to a manager for escalation to identify 
whether it merits a corrective action. It can also be routed to the support call center or the field service technician, 
who can provide more detailed information, to the customer for final approval of an implemented fix, to a supplier 
for a response to the incident, and so on. 

Workflows for product service requests work the same way as for other routable objects.

Attachments Tab

You can reference files and URLs from the Attachments tab of Agile PLM objects. Such files and URLs are generally 
referred to as attachments, or more formally as attachment files. Attachment files and URLs can be tracked and 
searched: when you attach a file to an object, it is also added to an automatically created object called a file folder—
an object of reference information from the File Folders class. 

The actual attachment files are stored in the Agile File Manager (also referred to as the file vault). Attachments may 
contain information that describes the object or a process. For example, if a specification describes a part or 
subassembly, it might have the following attachment files:

❑ Drawing files (such as CAD drawings) or scanned image files in viewable formats

❑ Files such as documents, non-viewable files, compressed (ZIP) files, and so on

You can view, copy, delete, and print attachment files. You can also check in and check out attachments (although 
you are actually checking file folder objects in and out). 

Submitting and Routing PSRs 
You submit and route PSRs using the Next Status button. The process is the same as for submitting and routing other 
routable objects. Before switching the PSR to a different status, always audit it to detect any errors that may prevent 
switching to a different status. 
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For information about the default workflows for PSRs, see the Agile PLM Administrator Guide.

When you submit a PSR, the quality analyst is notified by email. The quality analyst can also use the searches in 
Workflow Routings area of the Inbox or Quality Searches folder to find recently submitted PSRs.

A PSR can be closed (promoted to the Complete type status) in the following ways:

❑ A user with appropriate privileges can manually close a PSR.

❑ The Event and PSR Result fields in the Affected By table on the Relationships tab are set so that the PSR result is Closed 
when the status in the Event field is reached.
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CHAPTER 3
Quality Change Requests

This chapter covers how to create and work with quality change requests (QCRs), which include audits and 
corrective and preventive actions (CAPAs). It has the following sections:
❑ Creating a QCR
❑ Completing and Editing a QCR
❑ Submitting and Routing QCRs

Creating a QCR 
You must have the necessary privileges to create a QCR object. A QCR object is created the same way other Agile 
PLM objects are created. You can use the New Object button or the Save As feature.

To create a QCR in Java Client:

1 Click the New Object button . The New Object dialog box appears. 

2 In the Type list, select Audit or CAPA.

3 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

4 Click OK.

Agile Java Client creates the QCR object and displays the QCR (audit or CAPA) with the Cover Page tab on top.

To create a QCR in Web Client:

1 From the main toolbar, choose Create > Quality Change Request > Audit or Corrective and Preventive Actions. The Create 
Quality Change Request wizard appears.

2 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number. Click Next. The Enter Cover Page Information page appears.

3 Enter the required information. You can assign a workflow to route the QCR through the workflow statuses. 
Click Next. The Add Affected Items page appears.

4 Click the Add button to add one or more items, if necessary. The Add Affected Items Wizard appears.

5 You can search for existing items, or you can create a new item. 

You can add multiple items. For a single QCR, multiple items (for example, different parts, documents, 
assemblies) might need corrective action. See “Affected Items Tab” on page 2-7 for details.

6 Complete the appropriate fields on the Information page of the Add Affected Items Wizard. For an item, you can 
select the revision from Item Rev drop-down list and a site from the Affected Site drop-down list. Click Finish. The 
Add Affected Items page reappears.

7 You can click Finish, or click Next to add attachments. 
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8 On the Add Attachments page, click the Add button to add attachments if necessary.

9 Click Finish.

Agile Web Client creates the QCR and displays it with the Cover Page tab on top. If a workflow is not assigned to 
the QCR, the status is Unassigned. To assign a workflow, click the Edit button on the Cover Page and select a 
workflow from the Workflow drop-down list.

Notice that the Default Audits and Default CAPAs workflow statuses are different from those for other routable 
objects. The audit workflow starts with Prepared and the CAPA workflow starts with Identified.

Note The audit reminder will be sent to originator and quality administrator before the audit date. If you have 
Modify privileges, you can configure the audit reminder date in the 
\\<Agile_Home>\agileDomain\config\agile.properties file. Edit the value of the parameter 
pcm.notification.audit.reminder.backwarn.period=168. 
The default value is 168 hours (equal to 7 days). 

Creating a QCR Using Save As

You can use Save As to create a QCR. Save As copies data from a field in the existing object to the same field in the 
new object. If a field or list value in the existing object is not available in the new object, then that field or list value 
is not copied to the new object.

Note Because Page Three data applies to a specific subclass only, if you use Save As to create a new object of a 
different subclass, the Page Three data is not copied to the new object.

To create a QCR using Save As in Java Client:

1 Open the QCR you want to use as the basis for the new QCR. Right-click, and choose Save As.

Or choose File > Save As from the main toolbar.

The New Object dialog box appears. 

2 From the Type list, select Audit or CAPA.

3 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

4 Click OK.

Agile Java Client creates the QCR (audit or CAPA) and displays the QCR with the Cover Page tab on top.

5 Make any appropriate modifications on the tabs, and click Save.

To create a QCR using Save As in Web Client:   

1 Open the QCR you want to use as the basis for the new QCR.

2 Choose Actions > Save As.

3 Select Audit or CAPA from the Subclass list.

4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

5 Click Save. The new object opens.

6 Click the Edit button to make any appropriate modifications to the tabs, and click Save.

If the Agile PLM administrator has set the appropriate preferences, fields in the optional Page Two and Page Three 
sections are copied to the new object. For information about the behavior of Page Two and Page Three fields in your 
Agile PLM system, see your Agile PLM administrator. 
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Creating a QCR from a PSR or an Item

You can create a QCR directly from a PSR or an individual item. The QCR allows you to aggregate incoming 
problems into a routable quality record, perform root-cause failure analysis, and drive the problems to closure using 
standard CAPA (corrective and preventive actions) procedures. 

When you create a QCR from a PSR, the following information is copied:

❑ The PSR is added to the Affects table on the Relationships tab of the QCR. 

❑ The QCR is added to the Affected By table of the PSR. 

❑ All information on the Affected Items tab of the PSR is added to the PSR Items table on the Affected Items tab of the 
QCR.

You can set the event trigger to move the PSR to a specific status in the workflow when the QCR event occurs. 

When you create a QCR from an item to drive a problem to closure, the following information is copied:

❑ The item is added to the Affected Items tab of the QCR.

❑ The QCR is added to the QCRs table on the Quality tab of the item.

After the QCR is approved, you can route the item through the change to make sure that the defect is rectified and 
changed to new revision of the item.

To create a QCR from a PSR or an item in Java Client:

1 Open the PSR or item from which you want to create a QCR. 

2 Right-click in the object window, and choose Create Quality Change Request from the shortcut menu. 

3 Select Audit or CAPA from the Type list. 

4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number.

5 Click OK.

Agile Java Client creates the QCR. 

To create a QCR from a PSR or an item in Web Client:

1 Open the PSR or item from which you want to create a QCR. 

2 Choose Actions > Quality Change Request. The Quality Change Request Wizard appears.

3 Select Audit or Corrective and Preventive Actions from the Subclass drop-down list.

4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number. Click Finish.

Agile Web Client creates the QCR. 

Creating a Change from a QCR

You can create a change directly from the QCR. The change allows you to release the change order to fix the problem 
specified in the QCR. 

When you create a change from a QCR, the newly created change is added to the Affected By table of the Relationships 
tab. You can set the event trigger to move the QCR to a specific status in the workflow when the QCR event occurs. 

To create a change from a QCR in Java Client:

1 Open the QCR.

2 Right-click in the object window, and choose Create Change from the shortcut menu. 

3 Select a change object type from the Type list. You can select Deviation, ECO, ECR, MCO, or Stop Ship.
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4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number. Click OK.

5 All affected items of the QCR and PSR are listed in the Add Affected Items dialog box. Select items from the list 
of affected items and PSR items. If an item is already associated with a change, it still appears in this list so that 
you can initiate multiple changes related to one item. An item is listed only once, even if it appears in both the 
Affected Items and PSR Items tables. Click OK.

Agile Java Client creates the change. The newly created change is added to the Affected By table of the QCR 
Relationships tab. The selected items are copied to the Affected Items tab of the change. (This allows you to separate the 
QCR into multiple changes, each containing different items.)

To create a change from a QCR in Web Client:

1 Open the QCR.

2 Choose Actions > Create Change. The Create Change page appears.

3 Select a change type from the Subclass list. You can select Deviation, ECO, ECR, MCO, or Stop Ship.

4 In the Number field, accept the number that appears. Or you can type a number or click the AutoNumber button  
to automatically enter the next number. 

5 Click the button next to the Add Affected Items to Change field. Select the affected items from the Available Affected Items 
list, and click the right arrow to move them to the Selected Affected Items list. If an item is already associated with a 
change, it still appears in the list so that you can create multiple changes related to one item. An item is listed only 
once, even if it appears in both the Affected Items and PSR Items tables. Click OK. 

6 On the Create Change page, click Save.

Agile Web Client creates the change. The newly created change is added to the Affected By table of the QCR 
Relationships tab. The selected items are copied to the Affected Items tab of the change. (This allows you to separate the 
QCR into multiple changes, each containing different items.)

Completing and Editing a QCR 
After you have created a QCR, you can edit the report to provide additional information you did not include when 
you created it. You can also edit any information that has changed since the QCR was created.

1 Complete the appropriate fields on the Cover Page tab. See “Cover Page Tab” on page 3-5 for details.

2 Click the Affected Items tab. You can add, edit, or remove affected items using the Add, Edit, and Remove buttons. In 
the editable fields, enter text or use the drop-down lists. Adding, editing, and removing item is the same as for 
PSRs. For more details, see “Affected Items Tab” on page 2-7. 

In the PSR Items table, the items associated with PSRs are listed. If you add PSRs to the Affects table on the 
Relationships tab, all items of those PSRs are automatically added to the PSR Items table. If you are auditing or 
taking corrective action on items listed in the PSR, when the fix is checked and verified, the QCR can move to the 
Validate and then the Closed status.

3 To route the QCR through the workflow statuses, click the Workflow tab. If you assigned a workflow when you 
created the QCR, the assigned workflow chart appears on this tab. If it is not displayed, you can assign it by 
selecting a workflow on the Cover Page. 

You can change the status of workflow by clicking the Next Status button or clicking the required status in the 
workflow chart. When you change the status, you specify approvers and observers to be notified.

4 Click the Relationships tab. 

The Affected By and Affects table are similar to the Affected By and Affects tables for PSRs. For more details, see 
“Relationships Tab” on page 2-15.

5 Click the Attachments tab. 
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Add attachments as needed, or edit any of the existing attachments listed.

If you have the appropriate privileges, you can edit a QCR. (You cannot edit closed QCRs unless you have the specific 
privilege to do so).

To edit a QCR:

1 Open the QCR you want to edit.

2 In the editable fields, enter text or use the drop-down lists.

3 When you are finished, click Save.

Cover Page Tab

The following table lists and describes the fields on the QCR Cover Page tab. 

Table 3-1: QCR Cover Page tab fields

Field Completed... Contains...

QCR Number Automatically, when created. The number assigned to the QCR when you create it.

QCR Type Automatically, when created. The type (subclass) selected when you create the QCR.

Category Manually. Drop-down list of categories defined by the Agile PLM 
administrator, for example: 

Customer Complaint
Audit - External
Preventive Action

Description Usually manually; can contain a default. The maximum number of bytes is set by the Agile PLM 
administrator; can be up to 4000 bytes, including spaces 
and carriage returns (which count as two bytes).

Reason Usually manually; can contain a default. Reason for creating this QCR. Maximum number of 
bytes is set by the Agile PLM administrator; can be up to 
4000 bytes, including spaces and carriage returns (which 
count as two bytes).

Customer Manually. The customer associated with this QCR. 

Supplier Manually. Drop-down list of suppliers.

For example, you can initiate a QCR for suppliers to 
audit them or to generate a SCAR (supplier corrective 
action request) if the supplier has problems with its 
process, products, or other areas, and they need to be 
resolved.

Workflow If more than one workflow applies to the QCR, 
the workflow is selected manually; the workflow 
selection can be changed as long as the QCR is in 
the Pending status type. Selecting the blank field 
in the workflow drop-down list switches the 
QCR to the Unassigned status.

If no workflow is assigned, and you move the 
QCR to the next status from the Unassigned 
status, you are prompted to select a workflow

The name of the workflow used to move this QCR 
through the quality control process.

Quality 
Administrator

Selected manually from a drop-down list. 
Departments appear first in the list, followed by 
individual user names.

The default quality administrator.
If the workflow is defined to notify the default quality 
administrator, the user groups or user in this field 
receives notifications about the QCR. If this field is left 
blank, then the notifications are sent to every quality 
administrator on the list. If the notification definition in 
the workflow is blank, no notifications are sent.
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Affected Items Tab

The Affected Items tab of a QCR includes the Affected Items and PSR Items tables. 

The Affected Items table lists the items that are affected by the QCR. If you have the appropriate privileges, you can 
modify this table and add items that are affected by this QCR. For example, even though the quality incident reports 
Item A as the defect, after a root cause investigation, the defect was really due to Item B. You can add Item B to the 
Affected Items table. Item A automatically appears in the PSR Items table.

The PSR Items table lists the items that are referenced by problem reports and non-conformance reports associated 
with this QCR. This table is filled in automatically when you: 

❑ Associate a PSR with the QCR by adding the PSR to the QCR Relationships tab

❑ Associate a PSR with the QCR by adding the QCR to the PSR Relationships tab

❑ Create a QCR from a PSR 

Relationships Tab

The Relationships tab of a QCR is similar to that of a PSR. For details, see “Relationships Tab” on page 2-15.

Status Automatically, when created; updated as the 
QCR moves through the assigned workflow.

Workflow status. If no workflow has been selected, this 
field is Unassigned.

Originator Usually automatically, when created (with the 
default set by the Agile PLM administrator).

The originator or quality administrator who created the 
QCR.

Date Originated Usually automatically, when created. The date the QCR was created.

Date Submitted Automatically generated based on workflow 
status.

The date when the QCR moves to the Submitted status 
in the workflow.

Date Released Automatically generated based on workflow 
status.

The date when the QCR moves to the first Released 
status in the workflow.

Final Complete 
Date

Automatically, when the QCR enters the 
Complete type status.

The date the QCR moved into the Complete status type.

Preventive Action Usually manually; can contain a default. A proactive action to prevent the problem from 
happening again in the future. This applies only to 
CAPAs. 

Root Cause 
Analysis

Manually.

Maximum number of bytes is set by the Agile 
PLM administrator; can be up to 1023 bytes, 
including spaces and carriage returns (which 
count as two bytes).

The root cause of the problem.

For example, when there is a problem, engineers analyze 
why the problem occurred, all the way to the origin 
(root) of the problem. The information about their 
methods can be entered in this field. This applies only to 
CAPAs.

Planned Audit Date Manually. Date planned to audit the problem.

Audit Result Usually manually; can contain a default.

For example, when a corrective action is 
implemented, the quality analyst performs 
audits to make sure the corrective action really 
solved the problem. If the fix for the problem is 
validated, then the audit result is pass. 
Otherwise, the audit fails, and the quality analyst 
updates Audit Result field.

Audit process result. The default setting for audit result 
is Pass/Fail. Your administrator can define lists of other 
audit results. For more details, check with your 
administrator.

Incoming problem is audited and the result is specified.

Product Line(s) Usually manually; can contain a default. List of product lines defined by the Agile PLM 
administrator.

Table 3-1: QCR Cover Page tab fields (continued)

Field Completed... Contains...
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In the Affected By table, the default value of the QCR Event is set to the Released status and in the Affects table, the 
default value of the QCR Event is set to the Released status. 

If you have Quality Analyst privilege, you can set the default value to another status in Java Client by choosing menu 
option Admin > Settings > Data Settings > Classes (any class having Affects and Affected By) > User Interface Tabs > Affects/
Affected By > Attributes > Event/Result > DefaultValue. The modified default value will be effectively updated when the server 
gets restarted.

Workflow Tab

The Workflow tab displays a flowchart of the workflow you selected on the Cover Page. An Agile workflow is a 
sequence of statuses that a routable object follows as it goes through the different statuses in quality control process. 
The status with the orange background (Web Client) or the yellow background (Java Client) is the current status. 
The Signoff History table displays past workflow and signoff information for the QCR. 

For example, a QCR can be routed to a manager for escalation to identify whether corrective action should be taken. 
It can also be routed to the support call center or the field service technician, who can provide more detailed 
information, to the customer for final approval of an implemented fix, to a supplier for a response to the incident, 
and so on. 

Attachments Tab

You can reference files and URLs from the Attachments tab of Agile PLM objects. Such files and URLs are generally 
referred to as attachments, or more formally as attachment files. Attachment files and URLs can be tracked and 
searched: when you attach a file to an object, it is also added to an automatically created object called a file folder—
an object of reference information from the File Folders class. 

The actual attachment files are stored in the Agile File Manager (also referred to as the file vault). Attachments may 
contain information that describes the object or a process. For example, if a specification describes a part or 
subassembly, and it might have the following attachment files:

❑ Drawing files (such as CAD drawings) or scanned image files in viewable formats

❑ Files such as documents, non-viewable files, compressed (ZIP) files, and so on

You can view, copy, delete, and print attachment files. You can also check in and check out attachments (although 
you are actually checking file folder objects in and out).

Submitting and Routing QCRs 
You can submit QCRs using the Next Status button. The process is the same as for submitting other routable objects. 
Before switching the QCR to a different status, always audit the routable object to detect any errors that may prevent 
switching to a different status.

When you submit a QCR, the quality administrator is notified by email. The quality administrator can also use the 
defined searches in the Workflow Routings area of the Inbox or the Quality Searches folder to find recently submitted 
QCRs.

QCRs can be closed in the following ways:

❑ A user with appropriate privileges can manually close a QCR.

❑ The Event and QCR Result fields in the Affected By table on the Relationships tab are set so that the QCR result is 
Closed when the status in the Event field is reached. 
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